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1 Printer overview

● Printer views

● Printer specifications

● Printer hardware setup and software installation

For more information:

The following information is correct at the time of publication. For current information, see www.hp.com/
support/ljm11-m13.

HP's all-inclusive help for the printer includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software and firmware updates

● Join support forums

● Find warranty and regulatory information
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Printer views

Printer front view

2

5

6

1
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4

1 Output bin

2 Output bin extension

3 Input tray

4 Short media extender tool

5 Power button

6 Print-cartridge door lift-tab

7 Control panel
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Printer back view

2

1

3

4

1 USB port

2 Power connection

3 Slot for cable-type security lock

4 Serial number

Control-panel view

2

1

Table 1-1  HP LaserJet Pro M12a (base model)

1 Attention LED The Attention light blinks when the printer requires user attention, such as when the 
printer runs out of paper or a toner cartridge needs to be changed. If the light is on without 
blinking, the printer has experienced an error.

2 Ready LED The Ready light is on when the printer is ready to print. It blinks when the printer is 
receiving print data or canceling a print job.
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Table 1-2  HP LaserJet Pro M12w (wireless models)

1 Wireless button To detect wireless networks, press the wireless button. This button also enables and 
disables the wireless feature.

2 Wireless LED When the printer is searching for a network, the wireless light blinks. When the printer is 
connected to a wireless network, the wireless light is on.

3 Attention LED Indicates that the print cartridge door is open or other errors exist.

4 Ready LED When the printer is ready to print, the ready light is on. When the printer is processing data, 
the ready light blinks.

5 Cancel button Press this button for the following actions:

● To cancel the print job, press the Cancel button.

● Press and hold the button for 5 seconds to print a configuration page.
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Printer specifications
IMPORTANT: The following specifications are correct at the time of publication, but they are subject to change. 
For current information, see www.hp.com/support/ljm11-m13.

● Technical specifications

● Supported operating systems

● Mobile printing solutions (optional)

● Printer dimensions

● Power consumption, electrical specifications, and acoustic emissions

● Operating-environment range

Technical specifications
See www.hp.com/support/ljm11-m13 for current information.
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Supported operating systems
The following information applies to the printer-specific Windows PCLmS and OS X print drivers.

Windows: The HP Software Installer installs the PCLmS driver depending on the Windows operating system 
along with optional software when using the full software installer. See the software installation notes for more 
information.

OS X: Mac computers are supported with this printer. Download HP Easy Start either from 123.hp.com or from 
the Print Support page, and then use HP Easy Start to install the HP print driver and utility. HP Easy Start is not 
included in the in-box CD.

1. Go to 123.hp.com.

2. Follow the steps provided to download the printer software.

Operating system Print driver installed Notes

Windows® XP The HP PCLmS printer-specific print 
driver is installed for this operating 
system as part of the basic software 
installation.

Microsoft retired mainstream support for Windows XP in April 
2009. HP will continue to provide best-effort support for the 
discontinued XP operating system.

Windows Vista®, 32-bit and 64-
bit

The HP PCLmS printer-specific print 
driver is installed for this operating 
system as part of the basic software 
installation.

 

Windows 7, 32–bit and 64–bit The HP PCLmS printer-specific print 
driver is installed for this operating 
system as part of the basic software 
installation.

 

Windows 8, 32-bit and 64-bit

Windows 8.1, 32-bit and 64-bit

The HP PCLmS printer-specific print 
driver is installed for this operating 
system as part of the basic software 
installation.

 

Windows Server 2003, 32–bit 
and 64–bit

The HP PCLmS printer-specific print 
driver is installed for this operating 
system as part of the basic software 
installation. The basic installer installs 
the driver only.

Microsoft retired mainstream support for Windows Server 
2003 in July 2010. HP will continue to provide best-effort 
support for the discontinued Server 2003 operating system.

Windows Server 2008, 32-bit 
and 64-bit

The HP PCLmS printer-specific print 
driver is installed for this operating 
system as part of the full software 
installation.

 

OS X 10.8 Mountain Lion, 10.9 
Mavericks, 10.10 Yosemite, 
10.11 El Capitan

The OS X print driver and print utility 
are available for download from 
123.hp.com. The HP installer 
software for OS X is not included in 
the in-box CD.

Download HP Easy Start either from 123.hp.com or from the 
Print Support page, and then use HP Easy Start to install the 
HP print driver and utility.

1. Go to 123.hp.com.

2. Follow the steps provided to download the printer 
software.

NOTE: For a current list of supported operating systems, go to www.hp.com/support/ljm11-m13 for HP's all-
inclusive help for the printer.
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Mobile printing solutions (optional)
The printer supports the following software for mobile printing:

● HP ePrint software

● HP ePrint via email (Requires HP Web Services to be enabled and the printer to be registered with 
HP Connected)

● Android printing

Printer dimensions

1

23
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2
3

 Printer fully closed Printer fully open

1. Height 196 mm (7.7 in) 296 mm (11.7 in)

2. Width 349 mm (13.7 in) 349 mm (13.7 in)

3. Depth 229mm (9.0 in) 229 mm (9.0 in)

Weight 5.2 kg (11.5 lb)

Power consumption, electrical specifications, and acoustic emissions
See www.hp.com/support/ljm11-m13 for current information.

CAUTION: Power requirements are based on the country/region where the printer is sold. Do not convert 
operating voltages. This will damage the printer and void the printer warranty.

Operating-environment range

Environment Operating Storage

Temperature 15° to 32.5°C (59° to 90.5°F) -20° to 40°C (-4° to 104°F)

Relative humidity 10% to 80% relative humidity (RH), non-
condensing

10% to 90% RH, non-condensing
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Printer hardware setup and software installation
For basic setup instructions, see the Setup Poster and Getting Started Guide that came with the printer. For 
additional instructions, go to HP support on the Web.

Go to www.hp.com/support/ljm11-m13 for HP's all-inclusive help for the printer. Find the following support:

● Install and configure

● Learn and use

● Solve problems

● Download software and firmware updates

● Join support forums

● Find warranty and regulatory information
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2 Paper trays

● Load the input tray

● Load and print envelopes

For more information:

The following information is correct at the time of publication. For current information, see www.hp.com/
support/ljm11-m13.

HP's all-inclusive help for the printer includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software and firmware updates

● Join support forums

● Find warranty and regulatory information
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Load the input tray
1. If it is not already open, open the input tray.  

2. Adjust the paper width and length guides outward.  

10 Chapter 2   Paper trays ENWW



3. Load the paper face-up with the top forward in the 
input tray.

The orientation of the paper in the tray varies 
depending on the type of print job. For additional 
information, see the table below.

 

4. Adjust the paper guides inward until they are snug 
against the paper.
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Paper type Duplex mode How to load paper

Preprinted or letterhead 1-sided printing or 2-sided printing Face-up

Top edge leading into the printer

Prepunched 1-sided printing or 2-sided printing Face-up

Holes toward the left side of the printer
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Load and print envelopes

Introduction
The following information describes how to print and load envelopes. For the best performance, only 5 mm (.2 
in) of envelopes (4 to 6 envelopes) should be loaded into the priority feed tray, and only 10 envelopes should be 
loaded into the input tray.

To print envelopes, follow these steps to select the correct settings in the print driver.

Print envelopes
1. From the software program, select the Print option.

2. Select the printer from the list of printers, and then click or tap the Properties or Preferences button to 
open the print driver.

NOTE: The name of the button varies for different software programs.

NOTE: To access these features from a Windows 8 or 8.1 Start screen, select Devices, select Print, and 
then select the printer.

3. Click or tap the Paper/Quality tab.

4. In the Type is drop-down list, select Envelope.

5. Click the OK button to close the Document Properties dialog box.

6. In the Print dialog box, click the OK button to print the job.

Envelope orientation

Load envelopes in input tray face up, with the short, return address 
end leading into the printer.
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3 Supplies, accessories, and parts

● Order supplies, accessories, and parts

● Replace the toner cartridge 

For more information:

The following information is correct at the time of publication. For current information, see www.hp.com/
support/ljm11-m13.

HP's all-inclusive help for the printer includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software and firmware updates

● Join support forums

● Find warranty and regulatory information
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Order supplies, accessories, and parts

Ordering

Order supplies and paper www.hp.com/go/suresupply

Order genuine HP parts or accessories www.hp.com/buy/parts

Order through service or support providers Contact an HP-authorized service or support provider.

Order using the HP Embedded Web Server (EWS) To access, in a supported web browser on the computer, enter the 
printer IP address or host name in the address/URL field. The EWS 
contains a link to the HP SureSupply website, which provides 
options for purchasing Original HP supplies.

Supplies and accessories

Item Description Cartridge number Part number

Supplies

HP 79A Black Original LaserJet Toner 
Cartridge

Replacement black toner cartridge 79A CF279A

Customer self-repair parts
Customer Self-Repair (CSR) parts are available for many HP LaserJet printers to reduce repair time. More 
information about the CSR program and benefits can be found at www.hp.com/go/csr-support and 
www.hp.com/go/csr-faq.

Genuine HP replacement parts can be ordered at www.hp.com/buy/parts or by contacting an HP-authorized 
service or support provider. When ordering, one of the following will be needed: part number, serial number 
(found on back of printer), product number, or printer name.

● Parts listed as Mandatory self-replacement are to be installed by customers, unless you are willing to pay 
HP service personnel to perform the repair. For these parts, on-site or return-to-depot support is not 
provided under the HP product warranty.

● Parts listed as Optional self-replacement can be installed by HP service personnel at your request for no 
additional charge during the printer warranty period.
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Replace the toner cartridge 
● Introduction

● Toner-cartridge information

● Remove and replace the toner cartridge

Introduction
The following information provides details about the toner cartridge for the printer, and it includes instructions to 
replace it.

Toner-cartridge information
This printer indicates when the toner cartridge level is low and very low. The actual toner cartridge life remaining 
can vary. Consider having a replacement cartridge available to install when print quality is no longer acceptable.

Continue printing with the current cartridge until redistributing the toner no longer yields acceptable print quality. 
To redistribute the toner, remove the toner cartridge from the printer and gently rock the cartridge back and forth 
about its horizontal axis. For graphical representation, see cartridge replacement instructions. Reinsert the toner 
cartridge into the printer and close the cover.

To purchase cartridges or check cartridge compatibility for the printer, go to HP SureSupply at www.hp.com/go/
suresupply. Scroll to the bottom of the page and verify that the country/region is correct.

Item Description Cartridge number Part number

HP 79A Black Original LaserJet Toner 
Cartridge

Replacement black toner cartridge for M12a 
and M12w models.

79A CF279A

Do not remove the toner cartridge from its package until it is time to replace it.

CAUTION: To prevent damage to the toner cartridge, do not expose it to light for more than a few minutes. 
Cover the green imaging drum if the toner cartridge must be removed from the printer for an extended period of 
time. 

The following illustration shows the toner-cartridge components.

ENWW Replace the toner cartridge 17

http://www.hp.com/go/suresupply
http://www.hp.com/go/suresupply


2

1

1 Imaging drum

CAUTION: Do not touch the imaging drum. Fingerprints can cause print-quality problems.

2 Memory chip

CAUTION: If toner gets on clothing, wipe it off by using a dry cloth and wash the clothes in cold water. Hot water 
sets toner into fabric.

NOTE: Information about recycling used toner cartridges is in the toner-cartridge box.

Remove and replace the toner cartridge

1. Open the cartridge door.  
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2. Remove the used toner cartridge from the printer.  

3. Remove the new toner cartridge from the 
packaging. Place the used toner cartridge in the 
bag and box for recycling.

CAUTION: To prevent damage to the toner 
cartridge, hold the toner cartridge at each end. Do 
not touch the cartridge shutter or the roller 
surface.

 

4. Remove the sealing tape and the release tab from 
the new toner cartridge.

 

ENWW Replace the toner cartridge 19



5. Grasp both sides of the new toner cartridge and 
gently rock the toner cartridge to distribute the 
toner evenly inside the cartridge.

 

6. Align the new toner cartridge with the tracks inside 
the printer, and install the new toner cartridge until 
it is firmly seated.

 

7. Close the cartridge door.  
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4 Print

● Print tasks (Windows)

● Print tasks (OS X)

● Mobile printing

For more information:

The following information is correct at the time of publication. For current information, see www.hp.com/
support/ljm11-m13.

HP's all-inclusive help for the printer includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software and firmware updates

● Join support forums

● Find warranty and regulatory information
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Print tasks (Windows)

How to print (Windows)
The following procedure describes the basic printing process for Windows.

1. From the software program, select the Print option.

2. Select the printer from the list of printers. To change settings, click or tap the Properties or Preferences 
button to open the print driver.

NOTE: The name of the button varies for different software programs.

NOTE: To access these features from a Windows 8 or 8.1 Start screen app, select Devices, select Print, 
and then select the printer.

NOTE: For more information, click the Help (?) button in the print driver.

NOTE: The print driver might look different than what is shown here, but the steps are the same.
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3. Click or tap the tabs in the print driver to configure the available options. For example, set the paper 
orientation on the Finishing tab, and set the paper source, paper type, paper size, and quality settings on 
the Paper/Quality tab.

4. Click or tap the OK button to return to the Print dialog box. Select the number of copies to print from this 
screen.

5. Click or tap the OK button to print the job.
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Manually print on both sides (Windows) 
Use this procedure for printers that do not have an automatic duplexer installed or to print on paper that the 
duplexer does not support.

1. Load paper face-up in the input tray.

2. From the software program, select the Print option.

3. Select the printer from the list of printers, and then click or tap the Properties or Preferences button to 
open the print driver.

NOTE: The name of the button varies for different software programs.

4. Click or tap the Finishing tab.

5. Select the Print on both sides (manually) check box. Click the OK button to print the first side of the job.

6. Retrieve the printed stack from the output bin and, maintaining the paper orientation, place it with the 
printed-side facing down in the input tray.

7. At the computer, click the Continue button to print the second side of the job.

Print multiple pages per sheet (Windows)
1. From the software program, select the Print option.

2. Select the printer from the list of printers, and then click or tap the Properties or Preferences button to 
open the print driver.

NOTE: The name of the button varies for different software programs.

NOTE: To access these features from a Windows 8 or 8.1 Start screen app, select Devices, select Print, 
and then select the printer.

3. Click or tap the Finishing tab.

4. Select the number of pages per sheet from the Pages per sheet drop-down list.
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5. Select the correct Print page borders, Page order, and Orientation options. Click the OK button to close the 
Document Properties dialog box.

6. In the Print dialog box, click the OK button to print the job.

Select the paper type (Windows)
1. From the software program, select the Print option.

2. Select the printer from the list of printers, and then click or tap the Properties or Preferences button to 
open the print driver.

NOTE: The name of the button varies for different software programs.

NOTE: To access these features from a Windows 8 or 8.1 Start screen app, select Devices, select Print, 
and then select the printer.

3. Click or tap the Paper/Quality tab.

4. From the Paper type drop-down list, select the paper type that best describes your paper.

5. Select the option for the type of paper you are using, and then click the OK button.

6. Click the OK button to close the Document Properties dialog box. In the Print dialog box, click the OK button 
to print the job.
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Additional print tasks
Go to www.hp.com/support/ljm11-m13.

Instructions are available for performing specific print tasks, such as the following:

● Create and use printing shortcuts or presets

● Select the paper size, or use a custom paper size

● Select the page orientation

● Create a booklet

● Scale a document to fit a specific paper size

● Print the first or last pages of the document on different paper

● Print watermarks on a document
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Print tasks (OS X)

How to print (OS X)
The following procedure describes the basic printing process for OS X.

1. Click the File menu, and then click the Print option.

2. Select the printer.

3. Click Show Details or Copies & Pages, and then select other menus to adjust the print settings.

NOTE: The name of the item varies for different software programs.

4. Click the Print button.

Manually print on both sides (OS X)

NOTE: This feature is available if you install the HP print driver. It might not be available if you are using AirPrint.

1. Click the File menu, and then click the Print option.

2. Select the printer.

3. Click Show Details or Copies & Pages, and then click the Manual Duplex menu.

NOTE: The name of the item varies for different software programs.

4. Click the Manual Duplex box, and select a binding option.

5. Click the Print button.

6. Go to the printer, and remove any blank paper that is in Tray 1.

7. Retrieve the printed stack from the output bin and place it with the printed-side facing down in the input 
tray.

8. If prompted, touch the appropriate control panel button or open and close the front door to continue.

Print multiple pages per sheet (OS X)
1. Click the File menu, and then click the Print option.

2. Select the printer.

3. Click Show Details or Copies & Pages, and then click the Layout menu.

NOTE: The name of the item varies for different software programs.

4. From the Pages per Sheet drop-down list, select the number of pages that you want to print on each sheet.

5. In the Layout Direction area, select the order and placement of the pages on the sheet.

6. From the Borders menu, select the type of border to print around each page on the sheet.

7. Click the Print button.

ENWW Print tasks (OS X) 27



Select the paper type (OS X)
1. Click the File menu, and then click the Print option.

2. Select the printer.

3. Click Show Details or Copies & Pages, and then click the Media & Quality menu or the Paper/Quality menu.

NOTE: The name of the item varies for different software programs.

4. Select from the Media & Quality or Paper/Quality options.

NOTE: This list contains the master set of options available. Some options are not available on all printers.

● Media Type: Select the option for the type of paper for the print job.

● Print Quality: Select the resolution level for the print job.

● EconoMode: Select this option to conserve toner when printing drafts of documents.

5. Click the Print button.
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Additional print tasks
Go to www.hp.com/support/ljm11-m13.

Instructions are available for performing specific print tasks, such as the following:

● Create and use printing shortcuts or presets

● Select the paper size, or use a custom paper size

● Select the page orientation

● Create a booklet

● Scale a document to fit a specific paper size

● Print the first or last pages of the document on different paper

● Print watermarks on a document
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Mobile printing

Introduction
HP offers multiple mobile and ePrint solutions to enable easy printing to an HP printer from a laptop, tablet, 
smartphone, or other mobile device. To see the full list and to determine the best choice, go to www.hp.com/go/
LaserJetMobilePrinting.

NOTE: Update the printer firmware to ensure all mobile printing and ePrint capabilities are supported.

● Wireless Direct (wireless models only)

● HP ePrint software

● Android embedded printing

Wireless Direct (wireless models only)
Wireless Direct enables printing from a wireless mobile device without requiring a connection to a network or the 
Internet.

NOTE: Not all mobile operating systems are currently supported by Wireless Direct.

The following devices and computer operating systems support Wireless Direct:

● Android 4.0 and later tablets and phones with the HP Print Service or Mopria mobile printing plugin installed

● Most Windows 8.1 computers, tablets, and laptops that have the HP print driver installed

The following devices and computer operating systems to not support Wireless Direct, but can print to a printer 
that does:

● Apple iPhone and iPad

● Mac computers running OS X

For more information on Wireless Direct printing, go to www.hp.com/go/wirelessprinting.

Enable or disable Wireless Direct

Wireless Direct capabilities must be enabled first from the printer EWS.

1. After the printer is connected to the network, print a configuration page and identify the printer IP address. 
To print a configuration page, complete the following steps:

a. Press and hold the Cancel  button until the Ready  light begins blinking.

b. Release the Cancel  button.

2. Open a web browser, and in the address line, type the IP address or host name exactly as it displays on the 
printer configuration page. Press the Enter key on the computer keyboard. The EWS opens.

NOTE: If the web browser displays a message indicating that accessing the website might not be safe, 
select the option to continue to the website. Accessing this website will not harm the computer.
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3. Click the Networking tab.

4. On the Networking page, click Wireless Direct Setup. Select the checkbox, enter the network name (SSID) in 
the Name (SSID) field, and then click the Apply button. The IP address of the mobile device appears in the 
Networking page.

NOTE: To find the network name (SSID), click the Wireless Configuration menu in the Networking page.

Change the printer Wireless Direct name

Follow this procedure to change the printer Wireless Direct Printing (SSID) name using the HP Embedded Web 
Server (EWS):

Step one: Open the HP Embedded Web Server

1. Print a configuration page to determine the IP address or host name.

a. Press and hold the Cancel  button until the Ready  light begins blinking.

b. Release the Cancel  button.

2. Open a web browser, and in the address line, type the IP address or host name exactly as it displays on the 
printer configuration page. Press the Enter key on the computer keyboard. The EWS opens.

NOTE: If the web browser displays a message indicating that accessing the website might not be safe, 
select the option to continue to the website. Accessing this website will not harm the computer.

Step two: Change the Wireless Direct name

1. Click the Networking tab.

2. On the left navigation pane, click the Wireless Direct Setup link.

3. In the Name (SSID) field, enter the new name.

4. Click Apply.

HP ePrint software
The HP ePrint software makes it easy to print from a Windows or Mac desktop or laptop computer to any HP 
ePrint-capable printer. This software makes it easy to find HP ePrint-enabled printers that are registered to your 
HP Connected account. The target HP printer can be located in the office or at locations across the globe.

● Windows: After installing the software, open the Print option from within your application, and then select 
HP ePrint from the installed printers list. Click the Properties button to configure print options.

● OS X: After installing the software, select File, Print, and then select the arrow next to PDF (in the bottom 
left of the driver screen). Select HP ePrint.

For Windows, the HP ePrint software supports TCP/IP printing to local network printers on the network (LAN or 
WAN) to products that support UPD PostScript®.

Windows and OS X both support IPP printing to LAN or WAN network-connected products that support ePCL.

Windows and OS X also both support printing PDF documents to public print locations and printing using HP 
ePrint via email through the cloud.

ENWW Mobile printing 31



Go to www.hp.com/go/eprintsoftware for drivers and information.

NOTE: For Windows, the name of the HP ePrint Software print driver is HP ePrint + JetAdvantage.

NOTE: The HP ePrint software is a PDF workflow utility for OS X, and is not technically a print driver.

NOTE: HP ePrint Software does not support USB printing.

Android embedded printing
HP's built-in print solution for Android and Kindle enables mobile devices to automatically find and print to HP 
printers that are either on a network or within wireless range for Wireless printing.

The printer must be connected to the same network (sub-net) as the Android device.

The print solution is built into the many versions of the operating system.

NOTE: If printing is not available on your device, go to the Google Play > Android apps and install the HP Print 
Service Plugin.

For more information on how to use Android embedded printing and which Android devices are supported, go to 
www.hp.com/go/LaserJetMobilePrinting.
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5 Manage the printer

● Advanced configuration with HP Embedded Web Server (EWS) (wireless models only)

● HP Embedded Web Server sections

● Configure IP network settings

● Printer security features

● Energy-conservation settings

● Update the firmware

For more information:

The following information is correct at the time of publication. For current information, see www.hp.com/
support/ljm11-m13.

HP's all-inclusive help for the printer includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software and firmware updates

● Join support forums

● Find warranty and regulatory information
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Advanced configuration with HP Embedded Web Server (EWS) 
(wireless models only)

Use the HP Embedded Web Server to manage printing functions from a computer instead of the printer control 
panel.

● View printer status information

● Determine the remaining life for all supplies and order new ones

● View and change tray configurations

● View and change the printer control-panel menu configuration

● View and print internal pages

● Receive notification of printer and supplies events

● View and change network configuration

The HP Embedded Web Server works when the printer is connected to an IP-based network. The HP Embedded 
Web Server does not support IPX-based printer connections. Internet access is not needed to open and use the 
HP Embedded Web Server.

When the printer is connected to the network, the HP Embedded Web Server is automatically available.

NOTE: The HP Embedded Web Server is not accessible beyond the network firewall.

Open the HP Embedded Web Server (EWS) from a web browser

1. Print a configuration page to determine the IP address or host name.

a. Press and hold the Cancel  button until the Ready  light begins blinking.

b. Release the Cancel  button.

2. Open a web browser, and in the address line, type the IP address or host name exactly as it displays on the 
printer configuration page. Press the Enter key on the computer keyboard. The EWS opens.

NOTE: If the web browser displays a message indicating that accessing the website might not be safe, 
select the option to continue to the website. Accessing this website will not harm the computer.
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HP Embedded Web Server sections

Information tab
The Information pages group consists of the following pages:

● Device Status displays the status of the printer and HP supplies.

● Device Configuration shows the information found on the Configuration page.

● Supplies Status shows the status of HP supplies and provides part numbers. To order new supplies, click 
Order Supplies in the upper-right part of the window.

● Network Summary shows the information found on the Network Summary page.

Settings tab
Use this tab to configure the printer from your computer. If this printer is networked, always consult with the 
printer administrator before changing settings on this tab.

The Settings tab contains the Printing page where you can view and change the default print job settings.

Networking tab
Network administrators can use this tab to control network-related settings for the printer when it is connected 
to an IP-based network.

Links
Links are located in the upper-right part of the status pages. You must have Internet access to use any of these 
links. If you use a dial-up connection and did not connect when you first opened the HP Embedded Web Server, 
you must connect before you can visit these websites. Connecting might require that you close the 
HP Embedded Web Server and reopen it.

● Shop for Supplies. Click this link to connect to the Sure Supply website and order genuine HP supplies from 
HP or a reseller of your choice.

● Support. Connects to the printer support site. You can search for help regarding general topics.

ENWW HP Embedded Web Server sections 35



Configure IP network settings
● Introduction

● Printer sharing disclaimer

● View or change network settings

● Manually configure IPv4 TCP/IP parameters

Introduction
Use the following sections to configure the printer network settings.

Printer sharing disclaimer
HP does not support peer-to-peer networking, as the feature is a function of Microsoft operating systems and 
not of the HP printer drivers. Go to Microsoft at www.microsoft.com.

View or change network settings
Use the HP Embedded Web Server to view or change IP configuration settings.

1. Open the HP Embedded Web Server (EWS):

a. Print a configuration page to determine the IP address or host name.

i. Press and hold the Cancel  button until the Ready  light begins blinking.

ii. Release the Cancel  button.

b. Open a web browser, and in the address line, type the IP address or host name exactly as it displays 
on the printer configuration page. Press the Enter key on the computer keyboard. The EWS opens.

NOTE: If the web browser displays a message indicating that accessing the website might not be 
safe, select the option to continue to the website. Accessing this website will not harm the computer.

2. Click the Networking tab to obtain network information. Change settings as needed.

Manually configure IPv4 TCP/IP parameters
Use the EWS to manually set an IPv4 address, subnet mask, and default gateway.

1. Open the HP Embedded Web Server (EWS):

a. Print a configuration page to determine the IP address or host name.

i. Press and hold the Cancel  button until the Ready  light begins blinking.

ii. Release the Cancel  button.
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b. Open a web browser, and in the address line, type the IP address or host name exactly as it displays 
on the printer configuration page. Press the Enter key on the computer keyboard. The EWS opens.

NOTE: If the web browser displays a message indicating that accessing the website might not be 
safe, select the option to continue to the website. Accessing this website will not harm the computer.

2. Click the Networking tab.

3. In the IPv4 Configuration area, select Manual IP, and then edit the IPv4 configuration settings.

4. Click the Apply button.
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Printer security features

Introduction
The printer includes several security features to restrict who has access to configuration settings, to secure data, 
and to prevent access to valuable hardware components.

● Assign or change the system password using the HP Embedded Web Server

Assign or change the system password using the HP Embedded Web Server
Assign an administrator password for access to the printer and the HP Embedded Web Server so that 
unauthorized users cannot change the printer settings.

1. Open the HP Embedded Web Server (EWS):

Network-connected printers

a. Print a configuration page to determine the IP address or host name.

i. Press and hold the Cancel  button until the Ready  light begins blinking.

ii. Release the Cancel  button.

b. Open a web browser, and in the address line, type the IP address or host name exactly as it displays 
on the printer configuration page. Press the Enter key on the computer keyboard. The EWS opens.

NOTE: If the web browser displays a message indicating that accessing the website might not be 
safe, select the option to continue to the website. Accessing this website will not harm the computer.

2. On the Networking tab, click the Password link in the left navigation pane.

3. In the Password area, enter the password in the Password field.

4. Re-enter the password in the Confirm Password field.

5. Click the Apply button.

NOTE: Make note of the password and store it in a safe place.
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Energy-conservation settings
● Introduction

● Print with EconoMode

● Set the Sleep/Auto Off After Inactivity setting

● Delay When Ports Are Active setting

Introduction
The printer includes several economy features to conserve energy and supplies.

Print with EconoMode
This printer has an EconoMode option for printing drafts of documents. Using EconoMode can use less toner. 
However, using EconoMode can also reduce print quality.

HP does not recommend the full-time use of EconoMode. If EconoMode is used full-time, the toner supply might 
outlast the mechanical parts in the toner cartridge. Continue printing with the current cartridge until 
redistributing the toner no longer yields acceptable print quality. To redistribute the toner, remove the toner 
cartridge from the printer and gently rock the cartridge back and forth about its horizontal axis. For graphical 
representation, see cartridge replacement instructions. Reinsert the toner cartridge into the printer and close the 
cover. If print quality begins to degrade and is no longer acceptable, consider replacing the toner cartridge.

NOTE: If this option is not available in your print driver, you can set it using the HP Embedded Web Server.

1. From the software program, select the Print option.

2. Select the printer, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Click the EconoMode option.

Set the Sleep/Auto Off After Inactivity setting
Use the EWS to set the amount of idle time before the printer enters sleep mode.

Complete the following procedure to change the Sleep/Auto Off After Inactivity setting:

1. Open the HP Embedded Web Server (EWS):

Direct-connected printers

a. Open the Start menu, and then select Programs or All Programs.

b. Open the HP group, open the printer group, and then select HP Device Toolbox.

Network-connected printers

a. Print a configuration page to determine the IP address or host name.

i. Press and hold the Cancel  button until the Ready  light begins blinking.

ii. Release the Cancel  button.
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b. Open a web browser, and in the address line, type the IP address or host name exactly as it displays 
on the printer configuration page. Press the Enter key on the computer keyboard. The EWS opens.

NOTE: If the web browser displays a message indicating that accessing the website might not be 
safe, select the option to continue to the website. Accessing this website will not harm the computer.

2. Click the System tab, and then select the Energy Settings page.

3. Select the time for the Sleep/Auto Off After Inactivity, and then click the Apply button.

Delay When Ports Are Active setting

Method one: Use the HP Embedded Web Server (EWS)

1. Open the HP Embedded Web Server (EWS):

Network-connected printers

a. Print a configuration page to determine the IP address or host name.

i. Press and hold the Cancel  button until the Ready  light begins blinking.

ii. Release the Cancel  button.

b. Open a web browser, and in the address line, type the IP address or host name exactly as it displays 
on the printer configuration page. Press the Enter key on the computer keyboard. The EWS opens.

NOTE: If the web browser displays a message indicating that accessing the website might not be 
safe, select the option to continue to the website. Accessing this website will not harm the computer.

2. Click the Settings tab, and then select the Energy Settings page.

3. Select Delay when ports are active check box to enable or disable the setting.

Method two: Use the printer software

1. In the list of printers, right-click the name the printer, and then click the properties menu item to open the 
Printer properties dialog box.

2. Click the Device settings tab and navigate to the Energy settings area.

3. Select Delay when ports are active check box to enable or disable the setting.

NOTE: When the Delay when ports are active setting is selected, the printer will not shut down unless all ports 
are inactive. When the setting is not selected, the printer shuts down after a period of inactivity determined by 
the Shut Down After setting. An active network link or USB connection will prevent the printer from shutting 
down.
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Update the firmware
HP offers periodic printer updates, new Web Services apps, and new features to existing Web Services apps. 
Follow these steps to update the printer firmware for a single printer. When you update the firmware, Web 
Service apps will update automatically.

Update the firmware using the Firmware Update Utility
Use these steps to manually download and install the Firmware Update Utility from HP.com.

NOTE: You must have a print driver installed in order to use this method.

1. Go to www.hp.com/support, select your country/region language, click the Get software and drivers link, 
type the printer name in the search field, press the Enter button, and then select the printer from the list of 
search results.

2. Select the operating system.

3. Under the Firmware section, locate the Firmware Update Utility.

4. Click Download, click Run, and then click Run again.

5. When the utility launches, select the printer from the drop-down list, and then click Send Firmware.

NOTE: To print a configuration page to verify the installed firmware version before or after the update 
process, click Print Config.

6. Follow the on-screen instructions to complete the installation, and then click the Exit button to close the 
utility.
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6 Solve problems

● Customer support

● Interpret control-panel light patterns

● Restore the factory-set defaults

● Solve paper feed or jam problems

● Clear paper jams

● Improve print quality

● Solve direct-connect problems

● Solve wireless problems

For more information:

The following information is correct at the time of publication. For current information, see www.hp.com/
support/ljm11-m13.

HP's all-inclusive help for the printer includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software and firmware updates

● Join support forums

● Find warranty and regulatory information

ENWW 43

http://www.hp.com/support/ljm11-m13
http://www.hp.com/support/ljm11-m13


Customer support
Get telephone support for your country/region

Have the printer name, serial number, date of purchase, and 
problem description ready

Country/region phone numbers are on the flyer that was in the box 
with the printer or at www.hp.com/support/.

Get 24-hour Internet support, and download software utilities and 
drivers

www.hp.com/support/ljm11-m13

Order additional HP service or maintenance agreements www.hp.com/go/carepack

Register the printer www.register.hp.com
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Interpret control-panel light patterns
If the printer requires attention, an error code appears on the control-panel display.

Table 6-1  Status-light legend

Symbol for "light off"

Symbol for "light on"

Symbol for "light blinking"

Table 6-2  Control-panel light patterns

Light status State of the printer Action

All lights are off. The printer is in Auto-Off mode or is turned 
off.

Press the power button to deactivate the 
Auto-Off mode or to turn on the printer.

Status lights cycle The status lights cycle during the formatter 
initialization period or when the printer is 
processing a cleaning page.

No action is required. Wait for the 
initialization period to end. The printer 
should enter the ready state when the 
initialization period is finished.

Ready light is on, and attention light is off. The printer is in the ready state. No action is required. The printer is ready to 
receive a print job.
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Table 6-2  Control-panel light patterns (continued)

Light status State of the printer Action

Ready light is blinking, and attention light 
is off.

The printer is receiving or processing data. No action is required. The printer is receiving 
or processing a print job.

Attention light is blinking, and ready light is 
off.

The printer has experienced an error that can 
be corrected at the printer, such as a jam, an 
open door, the absence of a print cartridge, 
or the absence of paper in the proper tray.

Inspect the printer, determine the error, and 
then correct the error. If the error is the 
absence of paper in the proper tray or the 
printer is in a manual feed mode, put the 
proper paper in the tray and follow the 
onscreen instructions, or open and close the 
print-cartridge door to resume printing.

Attention light is blinking, and ready light is 
on.

The printer has experienced a continual error 
from which it will recover on its own.

If the recovery is successful, the printer 
continues to the processing data state and 
completes the job.

If the recovery is unsuccessful, the printer 
continues to the continuable error state. Try 
removing any media from the media path 
and turning the printer power off, and then 
on again.

The attention and ready lights are on. The printer has experienced a fatal error 
from which it cannot recover.

1. Turn off the printer or disconnect the 
power cord from the printer.

2. Wait 30 seconds, and then turn on the 
printer or reconnect the power cord to 
the printer.

3. Wait for the printer to initialize.

If the error persists, contact HP customer 
support.
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Table 6-2  Control-panel light patterns (continued)

Light status State of the printer Action

The wireless light is blinking. The printer is attempting to locate a wireless 
network.

No action is required.

The wireless light is on. The printer is connected to a wireless 
network.

No action is required.

The wireless light is off. The printer is not connected to a network, 
and the wireless unit in the printer might be 
turned off.

If the light is off, the printer is not connected 
to the network and the wireless unit in the 
printer might be off. Press the wireless 
button to try connecting to the network, or 
run the Wireless Configuration utility to 
configure the printer. To verify that the 
printer finds the network, print a 
configuration page. The printer should have 
an IP address assigned to it.

For information about connecting wirelessly 
to a network, see Solve wireless problems 
on page 64.

If the printer remains unable to connect to 
the network, uninstall and then reinstall the 
printer. If the error persists, contact a 
network administrator or refer to the user 
manual of the wireless router or access 
point.

ENWW Interpret control-panel light patterns 47



Restore the factory-set defaults
Restoring the factory-set defaults returns all of the printer and network settings to the factory defaults. It will 
not reset the page count, tray size, or language. To restore the printer to the factory-default settings, follow 
these steps.

CAUTION: Restoring the factory-set defaults returns all of the settings to the factory defaults, and it also 
deletes any pages that are stored in the memory.

1. Open the HP Embedded Web Server (EWS):

Network-connected printers

a. Print a configuration page to determine the IP address or host name.

i. Press and hold the Cancel  button until the Ready  light begins blinking.

ii. Release the Cancel  button.

b. Open a web browser, and in the address line, type the IP address or host name exactly as it displays 
on the printer configuration page. Press the Enter key on the computer keyboard. The EWS opens.

NOTE: If the web browser displays a message indicating that accessing the website might not be 
safe, select the option to continue to the website. Accessing this website will not harm the computer.

2. Click the Settings tab.

3. Select the Restore Factory Settings option, and click the Apply button.

The printer automatically restarts.
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Solve paper feed or jam problems
If the printer has recurring problems with paper feeding or with jams, use the following information to reduce the 
number of occurrences.

The printer does not pick up paper
If the printer does not pick up paper from the tray, try these solutions.

1. Open the printer and remove any jammed sheets of paper.

2. Load the tray with the correct size of paper for your job.

3. Make sure the paper size and type are set correctly in the software driver or EWS.

4. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides to the 
appropriate indentation in the tray.

5. Check the printer control panel to see if the printer is waiting for you to acknowledge a prompt to feed the 
paper manually. Load paper, and continue.

6. The pickup roller and separation pad might be contaminated.

The printer picks up multiple sheets of paper
If the printer picks up multiple sheets of paper from the tray, try these solutions.

1. Remove the stack of paper from the tray and flex it, rotate it 180 degrees, and flip it over. Do not fan the 
paper. Return the stack of paper to the tray.

2. Use only paper that meets HP specifications for this printer.

3. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different package.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray, straighten the 
stack, and then return some of the paper to the tray.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides to the 
appropriate indentation in the tray.

6. Make sure the printing environment is within recommended specifications.

Frequent or recurring paper jams
Follow these steps to solve problems with frequent paper jams. If the first step does not resolve the problem 
continue with the next step until you have resolved the problem.

1. If paper has jammed in the printer, clear the jam and then print a configuration page to test the printer.

2. Check that the tray is configured for the correct paper size and type on the in the software driver or EWS. 
Adjust paper settings if necessary.

3. Turn the printer off, wait 30 seconds, and then turn it on again.

4. Access the HP Embedded Web Server (EWS) to print a cleaning page to remove excess toner from inside the 
printer:
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a. On the Information tab of the EWS, click Print Info Pages.

b. In the Print Cleaning Page area, click Print to print a cleaning page.

5. Print a configuration page to test the printer.

a. Press and hold the Cancel  button until the Ready  light begins blinking.

b. Release the Cancel  button.

If none of these steps resolves the problem, the printer might need service. Contact HP customer support.

Prevent paper jams
To reduce the number of paper jams, try these solutions.

1. Use only paper that meets HP specifications for this printer.

2. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different package.

3. Use paper that has not previously been printed or copied on.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray, straighten the 
stack, and then return some of the paper to the tray.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides so they 
are touching the paper stack without bending it.

6. If you are printing on heavy, embossed, or perforated paper, use the manual feed feature and feed sheets 
one at a time.

7. Verify that the tray is configured correctly for the paper type and size.

8. Make sure the printing environment is within recommended specifications.
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Clear paper jams

Introduction
The following information includes instructions for clearing paper jams from the product.

● Paper jam locations

● Clear jams from the input tray

● Clear jams in the toner-cartridge area

● Clear jams in the output bin

Paper jam locations

1

2

3

1 Output bin

2 Input tray

3 Toner cartridge area

Clear jams from the input tray
When a jam occurs, the Attention  light blinks repeatedly on the printer control panel.
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1. Remove any loose paper from the input tray.  

2. Open the top cover.  

3. Remove the toner cartridge.  
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4. Remove any visible jammed paper visible in the 
input tray area. Use both hands to remove jammed 
paper to avoid tearing the paper.

 

5. Remove any jammed paper from the toner-
cartridge area. Use both hands to remove jammed 
paper to avoid tearing the paper.
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6. Reinsert the toner cartridge.  

7. Close the top cover.  

Clear jams in the toner-cartridge area
When a jam occurs, the Attention  light blinks repeatedly on the printer control panel.

1. Open the top cover.  
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2. Remove the toner cartridge.  

3. Remove any jammed paper from the toner-
cartridge area. Use both hands to remove jammed 
paper to avoid tearing the paper.
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4. Reinsert the toner cartridge.  

5. Close the top cover.  

Clear jams in the output bin
When a jam occurs, the Attention  light blinks repeatedly on the printer control panel.

1. Remove any visible jammed paper from the output 
bin area. Use both hands to remove jammed paper 
to avoid tearing the paper.
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2. Open the top cover.  

3. Remove the toner cartridge.  

4. Remove any jammed paper from the toner-
cartridge area.
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5. Reinsert the toner cartridge.  

6. Close the top cover.  
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Improve print quality

Introduction
If the printer is having print-quality problems, try the following solutions in the order presented to resolve the 
issue.

Print from a different software program
Try printing from a different software program. If the page prints correctly, the problem is with the software 
program from which you were printing.

Check the paper-type setting for the print job
Check the paper type setting when printing from a software program and the printed pages have smears, fuzzy 
or dark print, curled paper, scattered dots of toner, loose toner, or small areas of missing toner.

Check the paper type setting (Windows)

1. From the software program, select the Print option.

2. Select the printer, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Expand the list of Type is: options.

5. Expand the category of paper types that best describes your paper.

6. Select the option for the type of paper you are using, and click the OK button.

7. Click the OK button to close the Document Properties dialog box. In the Print dialog box, click the OK button 
to print the job.

Check the paper type setting (OS X)

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the printer.

3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list, and then 
click the Finishing menu.

4. Select a type from the Media Type drop-down list.

5. Click the Print button.

Check toner-cartridge status
Check the supplies status page for the following information:

● Estimated percentage of cartridge life remaining

● Approximate pages remaining
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● Part numbers for HP toner cartridges

● Number of pages printed

The printer prints the supplies status page when it prints the configuration page.

1. Press and hold the Cancel  button until the Ready  light begins blinking.

2. Release the Cancel  button.

Clean the printer

Print a cleaning page

1. On the Information tab of the EWS, click Print Info Pages.

2. In the Print Cleaning Page area, click Print to print a cleaning page.

Visually inspect the toner cartridge
Follow these steps to inspect each toner cartridge.

1. Remove the toner cartridge from the printer.

2. Check the memory chip for damage.

3. Examine the surface of the green imaging drum.

CAUTION: Do not touch the imaging drum. Fingerprints on the imaging drum can cause print-quality 
problems.

4. If you see any scratches, fingerprints, or other damage on the imaging drum, replace the toner cartridge.

5. Reinstall the toner cartridge, and print a few pages to see if the problem has resolved.

Check paper and the printing environment

Step one: Use paper that meets HP specifications

Some print-quality problems arise from using paper that does not meet HP specifications.

● Always use a paper type and weight that this printer supports.

● Use paper that is of good quality and free of cuts, nicks, tears, spots, loose particles, dust, wrinkles, voids, 
staples, and curled or bent edges.

● Use paper that has not been previously printed on.

● Use paper that does not contain metallic material, such as glitter.

● Use paper that is designed for use in laser printers. Do not use paper that is designed only for use in Inkjet 
printers.

● Use paper that is not too rough. Using smoother paper generally results in better print quality.
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Step two: Check the environment

The environment can directly affect print quality and is a common cause for print-quality or paper-feeding 
issues. Try the following solutions:

● Move the printer away from drafty locations, such as open windows or doors, or air-conditioning vents.

● Make sure the printer is not exposed to temperatures or humidity outside of printer specifications.

● Do not place the printer in a confined space, such as a cabinet.

● Place the printer on a sturdy, level surface.

● Remove anything that is blocking the vents on the printer. The printer requires good air flow on all sides, 
including the top.

● Protect the printer from airborne debris, dust, steam, grease, or other elements that can leave residue 
inside the printer.

Try a different print driver
Try a different print driver when printing from a software program and the printed pages have unexpected lines 
in graphics, missing text, missing graphics, incorrect formatting, or substituted fonts.

Download any of the following drivers from the HP Web site: www.hp.com/support/ljm11-m13.

HP PCLmS driver ● Provided as the default driver on the printer CD. This driver is automatically installed 
unless you select a different one.

● Recommended for all Windows environments

● Provides the overall best speed, print quality, and printer-feature support for most 
users

● Developed to align with the Windows Graphic Device Interface (GDI) for the best speed 
in Windows environments

● Might not be fully compatible with third-party and custom software programs that are 
based on PCL

Check the EconoMode settings
HP does not recommend the full-time use of EconoMode. If EconoMode is used full-time, the toner supply might 
outlast the mechanical parts in the toner cartridge. If print quality begins to degrade and is no longer acceptable, 
consider replacing the toner cartridge.

NOTE: This feature is available with the PCL 6 print driver for Windows. If you are not using that driver, you can 
enable the feature by using the HP Embedded Web Server.

Follow these steps if the entire page is too dark or too light.

1. From the software program, select the Print option.

2. Select the printer, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab, and locate the Print Quality area.

4. If the entire page is too dark, use these settings:
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● Select the 600 dpi option.

● Select the EconoMode check box to enable it.

If the entire page is too light, use these settings:

● Select the FastRes 1200 option.

● Clear the EconoMode check box to disable it.

5. Click the OK button to close the Document Properties dialog box. In the Print dialog, click the OK button to 
print the job.

Change print density
You can change the print density setting by from the printer properties dialog box.

1. Windows XP, Windows 7, Windows 8, Windows 8.1, Windows Server 2008, and Windows Server 2003 
(using the default Start menu view): Click Start, and then click Printers and Faxes.

-or-

Windows XP, Windows 7, Windows 8, Windows 8.1, Windows Server 2008, and Windows Server 2003 
(using the Classic Start menu view): Click Start, and then click Printers.

-or-

Windows Vista: Click Start, click Control Panel, and then in the category for Hardware and Sound click 
Printer.

2. In the list of printers, right-click the name of this product, and then click the Properties menu item to open 
the printer properties dialog box.

3. Click the Device settings tab, and then move the Print Density slider to the desired setting.

4. Click the Apply button to accept the setting, and then click the OK button to close the dialog box.
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Solve direct-connect problems
If you have connected the product directly to a computer, check the USB cable.

● Verify that the cable is connected to the computer and to the product.

● Verify that the cable is not longer than 2 m (6.56 ft). Replace the cable if necessary.

● Verify that the cable is working correctly by connecting it to another product. Replace the cable if necessary.
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Solve wireless problems
The installation program cannot detect the product during the setup process.

Cause Solution

The product is off. Verify that the product is on and ready. Restart the product if 
necessary.

The product is too far away from the wireless router or access point. Move the product closer to the wireless router or access point.

A personal firewall program is blocking communication. Temporarily disable the firewall program to install the product. Re-
enable the firewall program once the product installation is 
complete. If disabling the firewall allows you to communicate with 
the product, you might want to assign the product a static IP 
address, and then re-enable the firewall. For information about 
firewalls that are used in an HP environment, see www.hp.com/
support/XP_firewall_information.

The product is not communicating with the wireless router or access 
point.

● Verify that the wireless  light is on. If it is not on, press the 
wireless  button.

● Move the product closer to the wireless router or access point, 
and then try again.

● Restore the default wireless settings.

a. Turn the product off.

b. Press and hold the wireless  button and the cancel 
 button, and then turn the product on.

c. Hold the buttons until all the lights blink in unison, and 
then release the buttons.

If the error persists, uninstall the product, and then re-run the 
installer program. When prompted for network settings, provide the 
settings, and then continue the installation.
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The product cannot connect to the wireless network.

Cause Solution

The product wireless settings and the network settings do not 
match.

You might need to configure the product network settings 
manually. Verify that you know the following network settings:

● Communication mode

● Network name (SSID)

● Channel (ad-hoc networks only)

● Authentication type

Use the Wireless Configuration utility to configure the product to 
print on wireless network.

If the error persists, uninstall the product, and then re-run the 
installer program. When prompted for network settings, provide the 
settings, and then continue the installation.

The wireless router or access point is configured with a media 
access control (MAC) filter that is denying the product access to the 
network.

Configure the wireless router or access point so that the list of 
accepted MAC addresses includes the product hardware address. 
Refer to the device owners manual for help.

The wireless connection is sometimes disabled.

Cause Solution

The product environment might be affecting wireless 
communication. The following situations can affect wireless 
communication:

● A concrete or metal framed wall stands between the product 
and the wireless router or access point.

● Televisions, computer appliances, microwave ovens, 
intercoms, mobile/cellular phones, battery chargers, and AC 
power adapters are installed close to the network.

● A broadcast station or high-tension wire is located close to the 
network.

● A fluorescent light that is near the network is being switched 
on or off.

Move the product to a location where it can receive a steady signal 
from the wireless router or access point. Or you might need to move 
the wireless router or access point.
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